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 Important Information

Warranty
The NI PXI-8214 is warranted against defects in materials and workmanship for a period of one year from the date of shipment, as evidenced 
by receipts or other documentation. National Instruments will, at its option, repair or replace equipment that proves to be defective during the 
warranty period. This warranty includes parts and labor. 

The media on which you receive National Instruments software are warranted not to fail to execute programming instructions, due to defects 
in materials and workmanship, for a period of 90 days from date of shipment, as evidenced by receipts or other documentation. National 
Instruments will, at its option, repair or replace software media that do not execute programming instructions if National Instruments receives 
notice of such defects during the warranty period. National Instruments does not warrant that the operation of the software shall be 
uninterrupted or error free.

A Return Material Authorization (RMA) number must be obtained from the factory and clearly marked on the outside of the package before 
any equipment will be accepted for warranty work. National Instruments will pay the shipping costs of returning to the owner parts which are 
covered by warranty.

National Instruments believes that the information in this document is accurate. The document has been carefully reviewed for technical 
accuracy. In the event that technical or typographical errors exist, National Instruments reserves the right to make changes to subsequent 
editions of this document without prior notice to holders of this edition. The reader should consult National Instruments if errors are suspected. 
In no event shall National Instruments be liable for any damages arising out of or related to this document or the information contained in it.

EXCEPT AS SPECIFIED HEREIN, NATIONAL INSTRUMENTS MAKES NO WARRANTIES, EXPRESS OR IMPLIED, AND SPECIFICALLY DISCLAIMS ANY WARRANTY OF 
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. CUSTOMER’S RIGHT TO RECOVER DAMAGES CAUSED BY FAULT OR NEGLIGENCE ON THE PART OF 
NATIONAL INSTRUMENTS SHALL BE LIMITED TO THE AMOUNT THERETOFORE PAID BY THE CUSTOMER. NATIONAL INSTRUMENTS WILL NOT BE LIABLE FOR 
DAMAGES RESULTING FROM LOSS OF DATA, PROFITS, USE OF PRODUCTS, OR INCIDENTAL OR CONSEQUENTIAL DAMAGES, EVEN IF ADVISED OF THE POSSIBILITY 
THEREOF. This limitation of the liability of National Instruments will apply regardless of the form of action, whether in contract or tort, including 
negligence. Any action against National Instruments must be brought within one year after the cause of action accrues. National Instruments 
shall not be liable for any delay in performance due to causes beyond its reasonable control. The warranty provided herein does not cover 
damages, defects, malfunctions, or service failures caused by owner’s failure to follow the National Instruments installation, operation, or 
maintenance instructions; owner’s modification of the product; owner’s abuse, misuse, or negligent acts; and power failure or surges, fire, 
flood, accident, actions of third parties, or other events outside reasonable control.

Copyright
Under the copyright laws, this publication may not be reproduced or transmitted in any form, electronic or mechanical, including photocopying, 
recording, storing in an information retrieval system, or translating, in whole or in part, without the prior written consent of National 
Instruments Corporation.

Trademarks
National Instruments™, NI™, and ni.com™ are trademarks of National Instruments Corporation.

Product and company names mentioned herein are trademarks or trade names of their respective companies.

Patents
For patents covering National Instruments products, refer to the appropriate location: Help»Patents in your software, the patents.txt file 
on your CD, or ni.com/patents.

WARNING REGARDING USE OF NATIONAL INSTRUMENTS PRODUCTS
(1) NATIONAL INSTRUMENTS PRODUCTS ARE NOT DESIGNED WITH COMPONENTS AND TESTING FOR A LEVEL OF 
RELIABILITY SUITABLE FOR USE IN OR IN CONNECTION WITH SURGICAL IMPLANTS OR AS CRITICAL COMPONENTS IN 
ANY LIFE SUPPORT SYSTEMS WHOSE FAILURE TO PERFORM CAN REASONABLY BE EXPECTED TO CAUSE SIGNIFICANT 
INJURY TO A HUMAN.

(2) IN ANY APPLICATION, INCLUDING THE ABOVE, RELIABILITY OF OPERATION OF THE SOFTWARE PRODUCTS CAN BE 
IMPAIRED BY ADVERSE FACTORS, INCLUDING BUT NOT LIMITED TO FLUCTUATIONS IN ELECTRICAL POWER SUPPLY, 
COMPUTER HARDWARE MALFUNCTIONS, COMPUTER OPERATING SYSTEM SOFTWARE FITNESS, FITNESS OF COMPILERS 
AND DEVELOPMENT SOFTWARE USED TO DEVELOP AN APPLICATION, INSTALLATION ERRORS, SOFTWARE AND 
HARDWARE COMPATIBILITY PROBLEMS, MALFUNCTIONS OR FAILURES OF ELECTRONIC MONITORING OR CONTROL 
DEVICES, TRANSIENT FAILURES OF ELECTRONIC SYSTEMS (HARDWARE AND/OR SOFTWARE), UNANTICIPATED USES OR 
MISUSES, OR ERRORS ON THE PART OF THE USER OR APPLICATIONS DESIGNER (ADVERSE FACTORS SUCH AS THESE ARE 
HEREAFTER COLLECTIVELY TERMED “SYSTEM FAILURES”). ANY APPLICATION WHERE A SYSTEM FAILURE WOULD 
CREATE A RISK OF HARM TO PROPERTY OR PERSONS (INCLUDING THE RISK OF BODILY INJURY AND DEATH) SHOULD 
NOT BE RELIANT SOLELY UPON ONE FORM OF ELECTRONIC SYSTEM DUE TO THE RISK OF SYSTEM FAILURE. TO AVOID 
DAMAGE, INJURY, OR DEATH, THE USER OR APPLICATION DESIGNER MUST TAKE REASONABLY PRUDENT STEPS TO 
PROTECT AGAINST SYSTEM FAILURES, INCLUDING BUT NOT LIMITED TO BACK-UP OR SHUT DOWN MECHANISMS. 
BECAUSE EACH END-USER SYSTEM IS CUSTOMIZED AND DIFFERS FROM NATIONAL INSTRUMENTS' TESTING 
PLATFORMS AND BECAUSE A USER OR APPLICATION DESIGNER MAY USE NATIONAL INSTRUMENTS PRODUCTS IN 
COMBINATION WITH OTHER PRODUCTS IN A MANNER NOT EVALUATED OR CONTEMPLATED BY NATIONAL 
INSTRUMENTS, THE USER OR APPLICATION DESIGNER IS ULTIMATELY RESPONSIBLE FOR VERIFYING AND VALIDATING 
THE SUITABILITY OF NATIONAL INSTRUMENTS PRODUCTS WHENEVER NATIONAL INSTRUMENTS PRODUCTS ARE 
INCORPORATED IN A SYSTEM OR APPLICATION, INCLUDING, WITHOUT LIMITATION, THE APPROPRIATE DESIGN, 
PROCESS AND SAFETY LEVEL OF SUCH SYSTEM OR APPLICATION.



 Compliance

FCC/Canada Radio Frequency Interference Compliance

Determining FCC Class
The Federal Communications Commission (FCC) has rules to protect wireless communications from interference. The FCC 
places digital electronics into two classes. These classes are known as Class A (for use in industrial-commercial locations only) 
or Class B (for use in residential or commercial locations). Depending on where it is operated, this product could be subject to 
restrictions in the FCC rules. (In Canada, the Department of Communications (DOC), of Industry Canada, regulates wireless 
interference in much the same way.)
Digital electronics emit weak signals during normal operation that can affect radio, television, or other wireless products. By 
examining the product you purchased, you can determine the FCC Class and therefore which of the two FCC/DOC Warnings 
apply in the following sections. (Some products may not be labeled at all for FCC; if so, the reader should then assume these are 
Class A devices.)
FCC Class A products only display a simple warning statement of one paragraph in length regarding interference and undesired 
operation. Most of our products are FCC Class A. The FCC rules have restrictions regarding the locations where FCC Class A 
products can be operated.
FCC Class B products display either a FCC ID code, starting with the letters EXN, 
or the FCC Class B compliance mark that appears as shown here on the right.
Consult the FCC Web site at http://www.fcc.gov for more information.

FCC/DOC Warnings
This equipment generates and uses radio frequency energy and, if not installed and used in strict accordance with the instructions 
in this manual and the CE Marking Declaration of Conformity*, may cause interference to radio and television reception. 
Classification requirements are the same for the Federal Communications Commission (FCC) and the Canadian Department 
of Communications (DOC). 
Changes or modifications not expressly approved by National Instruments could void the user’s authority to operate the 
equipment under the FCC Rules.

Class A
Federal Communications Commission
This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to part 15 of the FCC 
Rules. These limits are designed to provide reasonable protection against harmful interference when the equipment is operated 
in a commercial environment. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and 
used in accordance with the instruction manual, may cause harmful interference to radio communications. Operation of this 
equipment in a residential area is likely to cause harmful interference in which case the user will be required to correct 
the interference at his own expense.

Canadian Department of Communications
This Class A digital apparatus meets all requirements of the Canadian Interference-Causing Equipment Regulations.
Cet appareil numérique de la classe A respecte toutes les exigences du Règlement sur le matériel brouilleur du Canada.

Class B
Federal Communications Commission
This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to part 15 of the 
FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. 
This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the 
instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference will not 
occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which can 
be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of 
the following measures:
• Reorient or relocate the receiving antenna.
• Increase the separation between the equipment and receiver.
• Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
• Consult the dealer or an experienced radio/TV technician for help.



Canadian Department of Communications
This Class B digital apparatus meets all requirements of the Canadian Interference-Causing Equipment Regulations.
Cet appareil numérique de la classe B respecte toutes les exigences du Règlement sur le matériel brouilleur du Canada.

Compliance to EU Directives
Readers in the European Union (EU) must refer to the Manufacturer’s Declaration of Conformity (DoC) for information* 
pertaining to the CE Marking compliance scheme. The Manufacturer includes a DoC for most every hardware product except 
for those bought for OEMs, if also available from an original manufacturer that also markets in the EU, or where compliance is 
not required as for electrically benign apparatus or cables.
To obtain the DoC for this product, click Declaration of Conformity at ni.com/hardref.nsf/. This Web site lists the DoCs 
by product family. Select the appropriate product family, followed by your product, and a link to the DoC appears in Adobe 
Acrobat format. Click the Acrobat icon to download or read the DoC.

* The CE Marking Declaration of Conformity will contain important supplementary information and instructions for the user 
or installer.



Conventions

The following conventions are used in this manual:

» The » symbol leads you through nested menu items and dialog box options 
to a final action. The sequence File»Page Setup»Options directs you to 
pull down the File menu, select the Page Setup item, and select Options 
from the last dialog box.

This icon denotes a note, which alerts you to important information.

This icon denotes a caution, which advises you of precautions to take to 
avoid injury, data loss, or a system crash.

bold Bold text denotes items that you must select or click in the software, such 
as menu items and dialog box options. Bold text also denotes parameter 
names.

italic Italic text denotes variables, emphasis, a cross reference, or an introduction 
to a key concept. This font also denotes text that is a placeholder for a word 
or value that you must supply.

monospace Text in this font denotes text or characters that you should enter from the 
keyboard, sections of code, programming examples, and syntax examples. 
This font is also used for the proper names of disk drives, paths, directories, 
programs, subprograms, subroutines, device names, functions, operations, 
variables, filenames and extensions, and code excerpts.
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1
Hardware Overview

The NI PXI-8214 PXI-to-Ultra2 SCSI Host Adapter provides an Ultra2 
SCSI interface to PXI or CompactPCI (cPCI) systems. The PXI-8214 is a 
16-bit Low Voltage Differential (LVD)/Single-Ended (SE) SCSI solution 
you can use to connect up to 15 SCSI devices. Data transfer rates of up to 
40 MegaTransfers (MT)/s (80 Mbytes/s) are possible. The PXI-8214 is an 
ideal solution for the PXI/cPCI system that requires true high-speed 
continuous disk operation.

PXI-8214 Features
The PXI-8214 includes the following features:

• LSI53C895A PXI-to-Ultra2 SCSI controller

• PXI/cPCI interface

– Supports 32-bit DMA bus master with 64-bit addressing

– Bursts up to 133 Mbytes/s at 33 MHz with zero wait-state bus 
master data

• SCSI interface

– Supports 16-bit LVD and SE signaling

– Contains 68-pin high-density (HD) connector

– Performs wide (16-bit) Ultra2, synchronous LVD, SCSI transfers 
up to 40 MT/s

– Supports up to 15 SCSI devices

– Maximum cable length for point-to-point connections—25 m

– Has active termination for one end of the SCSI bus

– Provides SCSI termination power source

– Onboard flash ROM for storage of SCSI BIOS

– SCSI bus activity LED
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Connectivity
The PXI-8214 connects up to 15 SCSI devices, including CD-ROM drives, 
hard disks, printers, and scanners. This interface can support single-ended 
and low voltage differential (LVD) devices.

Connectors
There are two connectors. Connector P1 is a cPCI backplane connector; 
connector J1 is a 68-contact alternative 3 shielded SCSI device connector.
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2
Installation

This chapter explains how to install the PXI-8214.

What You Need to Get Started

❑ PXI or cPCI system

❑ PXI-8214 interface board

❑ Driver for PXI-8214 (diskettes are included for Windows 2000 and 
Windows NT; Windows XP has native support; you can download 
drivers for Windows 98, Linux, and other operating systems from the 
National Instruments Web site at ni.com/support)

❑ SCSI cable

❑ SCSI device

❑ SCSI terminator (may be part of SCSI device)

Installing the PXI-8214

Caution Electrostatic discharge can damage several components on the PXI-8214. To 
avoid such damage in handling the board, touch the antistatic plastic package to a metal 
part of your system chassis before removing the board from the package.

Complete the following steps to install the PXI-8214:

1. Make sure your system is turned off. Keep the system plugged in so 
that it remains grounded while you install the PXI-8214.

2. Choose an unused PXI/cPCI slot in your system. The PXI-8214 
requires a slot that supports bus arbitration or bus master cards.

3. Remove the slot cover for the slot you have chosen.

4. Make sure the injector/ejector handle is in its downward position. 
Align the PXI-8214 with the card guides on the top and bottom of 
the slot.
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Caution Do not raise the injector/ejector handle as you insert the PXI-8214. The module 
will not insert properly unless the handle is in its downward position so that it does not 
interfere with the injector rail on the chassis.

5. Hold the handle as you slowly slide the module into the chassis until 
the handle catches on the injector/ejector rail.

6. Raise the injector/ejector handle until the module firmly seats into the 
backplane receptacle connectors. The front panel of the PXI-8214 
should be even with the chassis front panel.

Figure 2-1 shows how to install the PXI-8214 in a PXI/CompactPCI 
chassis.

Figure 2-1.  Installing the PXI-8214 into a PXI/CompactPCI Chassis

7. Screw the front panel of the PXI-8214 to the front panel mounting rail.

8. Power on your system.
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4 Injector/Ejector Rail
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Driver Installation

Windows XP
The PXI-8214 should automatically install with the correct driver. You can 
verify installation in the Device Manager.

After verifying that your operating system recognizes the PXI-8214 
properly, power down your system and connect your devices according to 
the Device Connection Guide section.

Windows 2000

Installation in an Existing Operating System
1. In the New Hardware Found Wizard, select Search for a suitable 

driver for my device and click Next. 

2. Check the Floppy Disk box and insert the Windows 2000 driver 
diskette into your floppy disk drive.

3. Windows 2000 should find the proper driver. You can verify 
installation in the Device Manager.

After verifying that your operating system recognizes the PXI-8214 
properly, power down your system and connect your devices according to 
the Device Connection Guide section.

New System Installation
Refer to the installation instructions in the WIN2000.TXT file on the 
NI PXI-8214 Driver for Windows 2000 disk. 

Windows NT

Installation in an Existing Operating System
1. In the Control Panel, double-click the SCSI Adapters icon.

2. Select the Drivers tab and click the Add button. In the box that 
appears, click the Have Disk… button.

3. Point the dialog box to the winnt/miniport/ directory on your 
floppy disk.

4. After you select the oemsetup.inf file, you will be prompted to 
restart your computer.
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5. You can verify the installation by returning to the Control Panel and 
double-clicking SCSI Adapters.

After verifying that your operating system recognizes the PXI-8214 
properly, power down your system and connect your devices according to 
the Device Connection Guide section.

New System Installation
Refer to the installation instructions in the WINNT.TXT file on the 
NI PXI-8214 Driver for Windows NT 4.0 disk. 

Windows 98
1. In the Add New Hardware Wizard, select Search for the best driver 

for your device. 

2. If your driver is on a floppy disk, select that option. If not, point the 
wizard to the driver location.

3. Windows 98 should find the proper driver file. You can verify 
installation in the Device Manager.

After verifying that your operating system recognizes the PXI-8214 
properly, power down your system and connect your devices according to 
the Device Connection Guide section.

Linux
Instructions for installing under Linux depend on the Linux kernel you are 
using. Refer to the readme.txt file included with the driver for 
instructions for your particular kernel. The PXI-8214 uses the 
LSI53C895A PCI-to-Ultra2 SCSI controller.

After verifying that your operating system recognizes the PXI-8214 
properly, power down your system and connect your devices according to 
the Device Connection Guide section.

Device Connection Guide
Each device on the SCSI bus must have a unique device number. The 
PXI-8214 has device number 7. Other devices on the bus must have their 
own unique number. For most devices, the user sets this device number 
with onboard switches. The device numbers do not need to be in any 
particular order, but they do need to be unique.
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Both ends of the SCSI bus must be terminated. The PXI-8214 default 
configuration terminates one end of the SCSI bus. (To change this 
configuration, refer to the Termination Configuration section.) The other 
end of your SCSI bus must be terminated also. Many SCSI devices have 
onboard termination that can be enabled, or you can add an external 
terminator to the end of the bus. Improper termination can cause 
unpredictable bus operation.

Cautions The PXI 8214 is a 16-bit SCSI interface using active termination that fully 
terminates one end of the 16-bit SCSI bus. The user must provide termination for the other 
bus end.

You can use 8-bit devices (such as most SCSI CD-ROMs), but you must be careful when 
cabling and terminating these devices. If only 8-bit devices reside on the SCSI bus, you can 
use the 8-bit termination on those devices as the end termination.

However, if both 8-bit and 16-bit devices are used, end termination must be from either a 
16-bit device at the end of the bus or an external 16-bit terminator. Terminating a 16-bit 
SCSI bus with an 8-bit device can result in unpredictable bus operation.

Each device must have at least 0.1 m (3.93 in.) of cabling between them. 
When connecting more than one device, you must use a daisy-chain 
configuration. A star configuration is not allowed.

Figure 2-2.  Single SCSI Device with Independent Termination

PXI 8214
Terminated 
Device ID 7

Each cable is at 
least 100 cm

SCSI CD-ROM 
Device ID 4

Termination of SCSI Bus



Chapter 2 Installation

NI PXI-8214 User Manual 2-6 ni.com

Figure 2-3.  Multiple SCSI Devices with Termination Handled by 
the Last SCSI Device on the Bus

Termination Configuration
In the default configuration shown in Figure 2-4, the PXI-8214 switches 
SW1-1 and SW1-2 are both set to ON to terminate the SCSI bus. In most 
applications, you should use the default configuration. To disable 
termination on the PXI-8214, you must set both the SW1-1 and SW1-2 
switches to the OFF position. In all setups, both switches should be either 
ON or OFF. If the switches are mismatched, the board will function 
incorrectly.

Figure 2-4.  SW1 Default Configuration

PXI 8214
Terminated 
Device ID 7

Each cable is at 
least 100 cm

SCSI CD-ROM 
Device ID 6

SCSI Hard Drive
Device ID 9
Set up for 
Termination of SCSI Bus

SW1

On

Off

1 2 3 4
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A
Specifications

This appendix lists the electrical, mechanical, environmental, safety, and 
compliance specifications of the PXI-8214.

Electrical

Physical
Board dimensions................................... 10.0 by 16.0 cm

(3.9 by 6.3 in.)

Slot requirements ................................... One peripheral slot

Weight .................................................... 0.13 kg (0.28 lb)

Temperature ........................................... 0 to 50 °C, operating
–20 to 70 °C, storage

Relative humidity ................................... 10 to 90% noncondensing, 
operating
5 to 95% noncondensing, storage

Functional shock .................................... 30 g peak, half-sine, 11 ms pulse

Random vibration................................... 5 to 500 Hz, 0.3 grms, operating
5 to 500 Hz, 2.4 grms, 
nonoperating

Voltage (V)

Current

Typical Maximum

+3.3 225 mA 300 mA

+5 150 mA 500 mA
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Safety
This product is designed to meet the requirements of the following 
standards of safety for electrical equipment for measurement, control, and 
laboratory use:

• IEC 61010-1, EN 61010-1

• UL 3121-1

• CAN/CSA C22.2 No. 1010.1

Note For UL and other safety certifications, refer to the product label or ni.com.

Electromagnetic Compatibility
EMC/EMI ...............................................CE, C-Tick, and FCC Part 15 

(Class A) Compliant

Electromagnetic emissions .....................EN 55011 Class A at 10 meters
FCC Part 15A above 1 GHz

Electromagnetic immunity .....................Evaluated to EN 61326:1997/ 
A1:1998, Table 1

Note For EMC compliance, operate this device with shielded cabling.

CE Compliance
This product meets the essential requirements of applicable European 
Directives, as amended for CE Marking, as follows:

• Low-Voltage Directive (safety): 73/23/EEC

• Electromagnetic Compatibility Directive (EMC): 89/336/EEC

Note See the Declaration of Conformity (DoC) for this product at ni.com for any 
additional regulatory compliance information. You can find the DoC using the search 
utility and product model number.
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B
Technical Support and 
Professional Services

Visit the following sections of the National Instruments Web site at 
ni.com for technical support and professional services:

• Support—Online technical support resources include the following:

– Self-Help Resources—For immediate answers and solutions, 
visit our extensive library of technical support resources available 
in English, Japanese, and Spanish at ni.com/support. These 
resources are available for most products at no cost to registered 
users and include software drivers and updates, a KnowledgeBase, 
product manuals, step-by-step troubleshooting wizards, hardware 
schematics and conformity documentation, example code, 
tutorials and application notes, instrument drivers, discussion 
forums, a measurement glossary, and so on.

– Assisted Support Options—Contact NI engineers and other 
measurement and automation professionals by visiting 
ni.com/ask. Our online system helps you define your question 
and connects you to the experts by phone, discussion forum, 
or email.

• Training—Visit ni.com/custed for self-paced tutorials, videos, and 
interactive CDs. You also can register for instructor-led, hands-on 
courses at locations around the world.

• System Integration—If you have time constraints, limited in-house 
technical resources, or other project challenges, NI Alliance Program 
members can help. To learn more, call your local NI office or visit 
ni.com/alliance.

If you searched ni.com and could not find the answers you need, contact 
your local office or NI corporate headquarters. Phone numbers for our 
worldwide offices are listed at the front of this manual. You also can visit 
the Worldwide Offices section of ni.com/niglobal to access the branch 
office Web sites, which provide up-to-date contact information, support 
phone numbers, email addresses, and current events.
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